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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.
Symantec’s support offerings include the following:
■

A range of support options that give you the flexibility to select the right
amount of service for any size organization

■

Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■

Upgrade assurance that delivers software upgrades

■

Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■

Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:
www.symantec.com/business/support/
All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:
www.symantec.com/business/support/
Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.
When you contact Technical Support, please have the following information
available:
■

Product release level

■

Hardware information

■

Available memory, disk space, and NIC information

■

Operating system

■

Version and patch level

■

Network topology

■

Router, gateway, and IP address information

■

Problem description:
■

Error messages and log files

■

Troubleshooting that was performed before contacting Symantec

■

Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:
www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:
www.symantec.com/business/support/
Customer Service is available to assist with non-technical questions, such as the
following types of issues:
■

Questions regarding product licensing or serialization

■

Product registration updates, such as address or name changes

■

General product information (features, language availability, local dealers)

■

Latest information about product updates and upgrades

■

Information about upgrade assurance and support contracts

■

Information about the Symantec Buying Programs

■

Advice about Symantec's technical support options

■

Nontechnical presales questions

■

Issues that are related to CD-ROMs or manuals

Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:
Asia-Pacific and Japan

customercare_apac@symantec.com

Europe, Middle-East, and Africa

semea@symantec.com

North America and Latin America

supportsolutions@symantec.com

About Symantec Connect
Symantec Connect is the peer-to-peer technical community site for Symantec’s
enterprise customers. Participants can connect and share information with other
product users, including creating forum posts, articles, videos, downloads, blogs
and suggesting ideas, as well as interact with Symantec product teams and
Technical Support. Content is rated by the community, and members receive
reward points for their contributions.
www.symantec.com/connect
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Overview of this release
This chapter includes the following topics:
■

About Veritas CommandCentral Enterprise Reporter

■

What’s new in CommandCentral Enterprise Reporter 5.2

■

About Symantec Operations Readiness Tools

About Veritas CommandCentral Enterprise Reporter
Veritas CommandCentral Enterprise Reporter by Symantec (Enterprise Reporter)
improves storage service management by aligning IT to business objectives.
Enterprise Reporter offers business information executives and storage
administrators the following:
■

Global views of storage assets mapped to your organization

■

Business insights into inventory utilization

■

On-demand customized reporting

■

Personalized dashboards for multiple users

Enterprise Reporter includes a central reporting interface for your storage
infrastructure that unifies information from multiple data centers and organizes
it along the lines of your business. If you are a business information executive,
you can use Enterprise Reporter to view your storage environment at the enterprise
level. You can then drill down into your organization's hierarchy, which could be
organized by location, departments, or any other logical business unit. This
summarized information enables you to assess trends in your storage environment,
which you can then analyze to assign responsibility.
If you are a storage administrator, you can use Enterprise Reporter to identify
capacity trends, review storage inventory, and determine your storage costs per
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business unit. With this information, you can promote storage accountability and
decrease costs.
Figure 1-1

Report types and scopes

Use Enterprise Reporter to answer questions like the following:
■

Which applications are growing out of control?

■

What will my tier 1 storage growth look like next year?

■

How is capacity trending in North America versus Europe?

■

How is storage allocated in the finance department?

■

Which department uses the highest percentage of tier 1 storage in the Toronto
data center?

Storage administrators and business users operate Enterprise Reporter with
CommandCentral Storage. While CommandCentral Storage provides storage
reporting for a single data center and is used at an operational level, Enterprise
Reporter lets you aggregate storage information from multiple data centers and
view storage assets by a variety of business dimensions. For example, if you are
a business information executive, you could use Enterprise Reporter to identify
the trend of unclaimed tier 1 storage in your New York and Zurich data centers.
You could then ask the storage administrators at each site to use CommandCentral
Storage to drill down to the details of which arrays or LUNs are unclaimed.

What’s new in CommandCentral Enterprise Reporter
5.2
CommandCentral Enterprise Reporter 5.2 includes the following new features
and enhancements:
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Thin provisioning

Enterprise Reporter now provides visibility into thin
provisioning.
Thin provisioning is a virtualization technology that allows
physical storage capacity to be allocated only when needed
from a pool of free storage. Thin provisioning extracts the
full value of thin provisioned arrays. Thin storage
environments allocate physical storage upon writes in a fixed
size.
Enterprise Reporter supports the following thin provisioning
storage systems:
■

Hitachi Universal Storage Platform V

■

EMC Symmetrix DMX-3 and DMX-4

■

EMC Symmetrix V-MAX IBM XIV

In Query Studio, the Host Storage Allocation reports provide
the following thin provisioning metrics:
■

Consumed Physical Capacity

■

Consumed Capacity Total Cost

■

Consumed Capacity Allocated to Host Directly

■

Consumed Adjusted Allocated Capacity

The Host Storage Allocation, Tiered Storage Analysis, and
Chargeback Analysis packages provide a Thin Status attribute.
Enterprise Reporter also provides the following thin
provisioning LUN attribute filters:
■

Only Thin Pool Source LUNs

■

Only Thin LUNs

For more information on thin provisioning, see
CommandCentral Enterprise Reporter User's Guide.
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Server virtualization
support

Enterprise Reporter supports server virtualization reporting
for VMware hosts and Solaris zones. In Query Studio, the Host
Consumption reports provide the following virtualization
server metrics:
■

Virtual Pool Allocated Capacity

■

Storage (LUN) Capacity Directly Allocated to Virtual
Machines

The Host Consumption reports also provide the following
filters:
■

Only VMware Hosts

■

Only Solaris Hosts

For more information on server virtualization reporting, see
CommandCentral Enterprise Reporter User's Guide.
Storage categorization
reporting

Enterprise Reporter now provides ad hoc storage
categorization reports for tracking different types of storage.
In Query Studio, the Host Consumption reports provide the
following storage categorization metrics:
■

Allocated SAN

■

Allocated DAS

■

Allocated IDE

■

Allocated Loop

■

Allocated ISCSI

■

Allocated File Storage

■

Claimed SAN

■

Claimed Loop

■

Claimed ISCSI

■

Claimed File Storage

■

Virtual Pool Allocated Capacity

■

Storage Capacity Directly Allocated to Virtual Machine

For more information on storage categorization reporting,
see CommandCentral Enterprise Reporter User's Guide.
ZFS

Enterprise Reporter provides limited support for Solaris ZFS
file systems. Enterprise Reporter discovers ZFS file systems,
but it does not discover child file systems to avoid the double
counting of ZFS capacities.
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Business view managment The Enterprise Reporter Console has a new Business Views
tab. On the Business Views tab, you can:
■

Add and remove business views

■

Edit a business view's structure

■

Add and remove business view instances

■

Assign and unassign storage objects

For more information on business views, see CommandCentral
Enterprise Reporter Administrator’s Guide.
New rollup support for
arrays

Enterprise Reporter now provides support for rolling up the
following:
■

IBM XIV arrays

■

FalconStor arrays

15
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Metamodel changes

Enterprise Reporter now provides RAC-aware attributes for
database objects (so that Enterprise Reporter does not double
count database capacities at the enterprise level). The
Database Analysis package now includes the following new
attributes for database objects:
Is Clustered flag. This flag is set to True only if an Oracle
database is part of RAC.
■ Is RAC Aware flag. This flag is set to True for a single
database that is part of a RAC configuration. This flag is
set to False for all other databases that are part of the same
RAC configuration.
■

The Database Analysis package now includes the following
new database attribute filters for database objects:
Only Clustered Databases. This filter excludes all of the
databases that are not part of a clustered environment.
■ Exclude Clustered Databases. This filter excludes all of
the databases that are part of a clustered environment.
■ Exclude Duplicate Clustered Databases. This filter
excludes duplicate clustered databases. Apply this filter
to include only one database from a RAC setup.
■

Enterprise Reporter now provides CSF-aware attributes for
file system objects (so that Enterprise Reporter does not double
count file system capacities at the enterprise level). The File
System Analysis package and the Chargeback Analysis package
now include the following new attributes for file system
objects:
■

Is CFS Aware flag. In CFS scenarios, this flag is set to True
for a single file system within a CFS configuration. This
flag is set to False for all other file systems that are part
of the same CFS configuration.

The File System Analysis package and the Chargeback Analysis
package now include the following new filter file system
objects (under File System Attribute Filters):
■

Exclude Duplicate Clustered Filesystems. This filter
excludes duplicate file systems from a CFS configuration.
Apply this filter to include only one file system in a CFS
configuration.
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Changes to sample reports Improvements were made to these sample reports:
■

The Inventory Summary Report (Sample Reports >
Inventory > Inventory Summary) now shows the database
count based on the number of unique database instances.

The Database Utilization Summary Report (Sample Reports
> Utilization > Host > Database utilization Summary) now
only shows the capacities for clustered database instances
once.
■ The Databases with Least Available Storage Report (Sample
Reports > Operational > Databases with Least Available
Storage) has a new Is Database Clustered column.
■ The File System Utilization Summary Report (Sample
Reports > Utilization > Host > File System Utilization
Summary) now only shows the capacities for clustered file
systems once.
■ The File System/Volume Consumption Report (Sample
Reports > Utilization > Host > File System/Volume
Consumption Report) now only shows clustered filesystems
once.
■

About Symantec Operations Readiness Tools
Symantec™ Operations Readiness Tools (SORT) is a set of Web-based tools and
services that lets you proactively manage your Symantec enterprise products.
SORT automates and simplifies administration tasks, so you can manage your
data center operations more efficiency and get the most of out of your Symantec
products.
SORT lets you do the following:
■

Collect, analyze, and report on server configurations across UNIX or Windows
environments. You can use this data to do the following:
■

Assess whether your systems are ready to install or upgrade Symantec
enterprise products

■

Tune environmental parameters so you can increase performance,
availability, and use

■

Analyze your current deployment and identify the Symantec products and
licenses you are using

■

Upload configuration data to the SORT Web site, so you can share information
with coworkers, managers, and Symantec Technical Support

■

Compare your configurations to one other or to a standard build, so you can
determine if a configuration has "drifted"
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■

Search for and download the latest product patches

■

Get notifications about the latest updates for:
■

Patches

■

Hardware Compatibility Lists (HCLs)

■

Array Support Libraries (ASLs)

■

Array Policy Modules (APMs)

■

VCS agents

■

Determine whether your Symantec enterprise product configurations conform
to best practices

■

Search and browse the latest product documentation

■

Look up error code descriptions and solutions

To access SORT, go to:
http://sort.symantec.com
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System requirements
This chapter includes the following topics:
■

Operating system requirements

■

Disk space requirements to install Enterprise Reporter

■

System resources recommended for different network sizes

■

Web browser requirements

■

Co-existence of Enterprise Reporter with other Symantec products

Operating system requirements
Table 2-1 provides operating system requirements for Enterprise Reporter.
Table 2-1

Enterprise Reporter operating system requirements

Operating systems supported

Required patches and components

Windows Server 2003 SP2 (32-bit and 64-bit) ■ Windows Installer version 1.1 or higher
and Windows Server 2008 SP1 (32-bit) for ■ Windows Management Instrumentation
the following editions:
■

Standard

■

Datacenter

■

Enterprise

■

Web

You can install Enterprise Reporter on
virtual machines that run supported versions
of the Windows Server operating system.
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Table 2-1

Enterprise Reporter operating system requirements (continued)

Operating systems supported

Required patches and components

Solaris 9 and 10 (SPARC only) with End User ■ Sun Enterprise Authentication
as the minimum requirement for the
Mechanism (SEAM)
software group
■ Required patches for Solaris 9:
■ 111711-14

■

■

111712-14

■

111722-04

■

112233-12

■

112874-37

■

112963-23

■

113225-07

■

117560-03

Required patches for Solaris 10:
■ 117461-06
■

118833-36

■

119254-34

■

122032-03

■

125418-01

We do not support installation of Enterprise Reporter on non-English operating
systems.

Disk space requirements to install Enterprise
Reporter
This section provides disk space and temp space requirements to install Enterprise
Reporter.
Review system resource requirements for information about processor, memory,
and database disk space.
See “System resources recommended for different network sizes” on page 22.
Table 2-2 lists space requirements to install or upgrade Enterprise Reporter 5.2
on Solaris.
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Enterprise Reporter 5.2 disk and temp space requirements on Solaris

Table 2-2

Type of
install

(a)

(b)

(c)

(d)

(e)

Total disk
space
required

Total
non-relocatable
disk space
required in

Total
relocatable
disk space
required in

Temp space Temp
in /var/tmp space in

/opt

/opt/VRTSccer

/opt/VRTSccer

Fresh
install

2913 MB

366 MB

2487 MB

220 MB

432 MB

Upgrade
from 5.0
MP1

423 MB

45 MB

389 MB

220 MB

765 MB

Consider the following information:
■

Column (a) is the total disk space required on all file systems including /, /opt,
/usr, and /etc.

■

Column (c) is the disk space required on the file system where packages are
relocated.

■

Columns (d) and (e) are the total temporary disk space required at the time of
the install. This space is released at the end of the install.

■

Upgrade values are additional disk space required for the upgrade.

■

The numbers given are +10% of the actual observed disk space consumed, and
not the exact values. This allows for the way that Solaris allocates disk space
to files.

Table 2-3 lists space requirements to install Enterprise Reporter on Windows.
Table 2-3

Enterprise Reporter 5.2 disk and temp space requirements on
Windows

Disk space required

Temp space required

System drive: 157 MB

500 MB

Install drive: 2260 MB or 2.2 GB

Consider the following information:
■

The install drive is the drive on which you choose to install Enterprise Reporter.
This install location (along with the drive) is user selectable, meaning it is
relocatable for the Windows operating system.

21

22

System requirements
System resources recommended for different network sizes

■

The system drive is the drive on which the operating system is installed. Some
shared components, such as VRTSjre, and the install logs reside on this drive.

■

The total disk space consumed is the sum of that required for the system drive
and install drive. This means that if you choose to install Enterprise Reporter
in the default install directory, the space required would be 2417 MB.

■

The numbers given are +10% of the actual observed disk space consumed, and
not the exact values. This allows for the way that Windows allocates disk space
to files.

System resources recommended for different network
sizes
As the size of your storage network increases, greater system resources are
required to accommodate the larger database of objects. The following tables
provide recommended CPU, memory, and disk space resources for running
Enterprise Reporter on small, medium, and large storage networks.
Note the following:
■

The number of hosts refers to the amount of hosts for which Enterprise
Reporter rolls up data.

■

The disk space for the Enterprise Reporter host is for the installation directory
and configuration directory.

■

The recommendations apply to Solaris and Windows.

Table 2-4 lists the recommendations for disk space and temp space based on
network size.
Table 2-4

Disk space and temp space recommended for Enterprise Reporter
with small, medium, and large networks

Network size

Enterprise Reporter host

Oracle database

Small (500 hosts)

Disk space: 10 GB

■

Disk space: 10 GB

■

Temp space: 1 GB

■

Disk space: 20 GB

■

Temp space: 2 GB

■

Disk space: 40 GB

■

Temp space: 2 GB

Medium (1000 hosts)

Large (2000 hosts)

Disk space: 10 GB

Disk space: 10 GB
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Table 2-5 lists the recommendations for system CPU and memory based on network
size.
Table 2-5

System CPU and memory recommended for Enterprise Reporter
with small, medium, and large networks

Network size

Enterprise Reporter host
with local Oracle database

Small (500 hosts)

■

CPU: Quad processor

■

CPU: Dual processor

■

Memory: 8 GB

■

Memory: 4 GB

■

CPU: Quad processor

■

CPU: Dual processor

■

Memory: 12 GB

■

Memory: 8 GB

■

CPU: Quad processor

■

CPU: Dual processor

■

Memory: 12 GB

■

Memory: 8 GB

Medium (1000 hosts)

Large (2000 hosts)

Enterprise Reporter host
with remote Oracle database

Web browser requirements
One of the following web browsers is required to run the Console:
■

■

Microsoft Internet Explorer 6.x or 7.x (Windows only)
■

Secure Sockets Layer (SSL) 3.0 ActiveX scripting must be enabled

■

For Internet Explorer 6.0 on Windows 2000 (Server, Advanced Server, or
Datacenter Server) and Windows 2003 Server (Standard Edition, Datacenter
Edition, Enterprise Edition, or Web Edition), set the default Intranet zone
security level to MEDIUM or lower.

■

Using Microsoft Internet Explorer 7.x on Windows Server 2008 and
Windows Vista is not supported.

Mozilla Firefox 2.x and 3.x (Windows only)

Note: Support for Firefox is limited in Cognos. You will not be able to create or
edit advanced reports if you use Firefox.
Your browser must support either JScript 5.5 (provided with Microsoft Internet
Explorer 6 or later) or JavaScript 1.2.
If you are using pop-up blockers (including Yahoo Toolbar or Google Toolbar),
either disable them or configure them to accept pop-ups from the Enterprise
Reporter Management Server to which you will connect.
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Co-existence of Enterprise Reporter with other
Symantec products
Several Symantec products may be installed on the same host in a typical data
storage management environment.
Table 2-6 lists the products (or product components) that can co-exist on a host
with Enterprise Reporter 5.2.
Table 2-6

Enterprise Reporter co-existence with other Symantec products

Symantec product component

Co-install possible?

Cluster Server Management Console 5.5

Yes

CommandCentral 5.1 Management Server Yes
On Windows hosts, if you want to install the
CommandCentral 5.1 Management Server on
a host where Enterprise Reporter 5.2 is
already installed, you need to obtain a hotfix.
CommandCentral 5.1 managed host

Yes
On Windows hosts, if you want to install the
CommandCentral 5.1 managed host on a host
where Enterprise Reporter 5.2 is already
installed, you need to obtain a hotfix.

NetBackup 6.5.4 Client

Yes

Storage Foundation 5.0 MP3

Yes

Storage Foundation 5.1 for Windows

Yes

Storage Foundation Manager 2.0
Management Server

Yes on Solaris
No on Windows

Storage Foundation Manager 2.0 managed Yes
host
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Fixed issues
This chapter includes the following topics:
■

Issues fixed in CommandCentral Enterprise Reporter 5.2

Issues fixed in CommandCentral Enterprise Reporter
5.2
Table 3-1 lists the known issues fixed in this release of Enterprise Reporter.
Table 3-1

Issues fixed in Enterprise Reporter 5.2

Incident

Description

1110343

When two or more Oracle RAC instances use the same database, Enterprise
Reporter no longer counts capacity values more than once.
The default reports related to databases are fixed. For user-generated
reports, apply the Exclude Duplicate Clustered Database filter to avoid
counting database capacities more than once.

1522801

In the previous version of Enterprise Reporter, selecting a report from
the View Reports List pane caused Enterprise Reporter to prompt you for
a user name and password but the credentials were not accepted.
This issue is fixed.

1712857

In the previous version of Enterprise Reporter, when a host consumed
storage from aggregate LUNs and RAID-5 LUNs that belong to an EMC
Symmetrix storage array, incorrect capacities appeared in the SAN
Chargeback reports. This issue affected the total physical capacity in the
SAN Chargeback Summary report, and the physical capacity in the SAN
Chargeback Detail report.
These capacities now calculate correctly.
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Table 3-1

Issues fixed in Enterprise Reporter 5.2 (continued)

Incident

Description

1712911

Previously, when a host belonged to a cluster and had exclusive storage,
incorrect capacities appeared in the SAN Chargeback reports. Also, when
a host consumed storage from a 3PAR array, incorrect capacities appeared
in the SAN Chargeback Detail reports.
These capacities now calculate correctly.

1719078

The cron job that initiates data rollup no longer remains after you uninstall
Enterprise Reporter from a Solaris host.

1933840

In the previous version of Enterprise Reporter, installing the Management
Server on a Windows host that includes Storage Foundation 5.1 SP1
resulted in the Enterprise Reporter product installer closing at the start
of the installation.

1946096

The Windows version of Enterprise Reporter now supports usernames
that contain the following special characters:
.?>}{|!#$%^&*()-_+=~

2059207

Prior to Enterprise Reporter 5.1 Hot Fix 2, Enterprise Reporter did not
roll up RAC-aware attributes on database objects. Because of the way RAC
configurations are set up, Enterprise Reporter counted the same capacity
two or more times at the enterprise level. To resolve the double-counting
and multiple-counting issues, Enterprise Reporter now provides RAC-aware
attributes in the form of flags or filters at the metamodel level. Enterprise
Reporter now rolls up RAC attributes as database dimensions.

2065096

Prior to Enterprise Reporter 5.1 Hot Fix 2, Enterprise Reporter did not
roll up CFS-aware attributes on file system objects. Because of the way
CFS configurations are set up, Enterprise Reporter counted the same
capacities two or more times at the enterprise level. To resolve the
double-counting and multiple-counting issues, Enterprise Reporter now
provides CFS-aware attributes in the form of flags or filters at the
metamodel level. Enterprise Reporter now rolls up CFS attributes as file
system dimensions.

2071498

Enterprise Reporter no longer fails on Windows if the 8dot3 flag is disabled
('ntfsDisable8dot3NameCreation = 1').
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Software limitations
This chapter includes the following topics:
■

Cannot log in to the Console using Internet Explorer when the host name
includes an underscore (1447601)

■

Invalid certificate error appears in Firefox (1708229)

■

Cannot view reports in Excel format when you use Internet Explorer 7.x
(1726839)

Cannot log in to the Console using Internet Explorer
when the host name includes an underscore
(1447601)
If the Management Server’s host name includes an underscore, you cannot log in
to the Console using Internet Explorer. This occurs because of a limitation in
Internet Explorer.
Workaround
Do one of the following:
■

If you use Internet Explorer, connect to the Console using the Management
Server’s IP address. For example, type https://ipaddress:8443 in the
browser’s address field.

■

Use Firefox to connect to the Console.

Invalid certificate error appears in Firefox (1708229)
If you access the Enterprise Reporter Console and then access a different Enterprise
Reporter Console from the same browser window session, you may receive an
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invalid certificate error message. The error message appears when the Console
tries to load Cognos—for example, in the Enterprise Reporter dashboard.
Workaround
Remove the previous certificate from Firefox.
To remove the previous certificate from Firefox

1

In Firefox, click Tools > Options > Advanced > Encryption > View Certificates.

2

Select the Cognos certificate.

3

Click Delete.

4

Restart Firefox

Cannot view reports in Excel format when you use
Internet Explorer 7.x (1726839)
When you try to view a report in Excel format using Internet Explorer 7.x, a new
window appears and then immediately disappears. The window disappears due
to browser settings.
Workaround
Enable automatic prompting for file downloads.
To enable automatic prompting for file downloads

1

In Internet Explorer, click Tools > Internet Options > Security.

2

Click Local intranet.

3

Click Custom Level...

4

Under Downloads > Automatic prompting for file downloads, click Enable.
Then, click OK.

5

Click Internet.

6

Repeat steps 3 and 4.

7

Click Trusted sites.

8

Repeat steps 3 and 4.

9

Click OK.
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Known issues
This chapter includes the following topics:
■

Install, uninstall, and upgrade issues

■

Console and report issues

■

User management issues

■

Data rollup issues

■

Business view issues

■

Documentation issues

Install, uninstall, and upgrade issues
The following notes pertain to known issues that you might encounter when you
install, uninstall, or upgrade Enterprise Reporter 5.2.

Special characters cause configuration failure (1651763)
Configuration of Enterprise Reporter fails when the installation directory path
contains any of the following special characters: `~!@$^*-_+=|{}[]';.,
The Enterprise Reporter installer does not allow these characters in the installation
path. This issue occurs on the Windows platform.
Workaround
Do not use the special characters in the installation directory name.
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Upgrading Enterprise Reporter fails in co-existence setup (1671955)
A co-existence setup means a setup where CommandCentral Storage,
CommandCentral Storage Change Manager, and CommandCentral Enterprise
Reporter are all installed on the same host. In a case where you upgrade Enterprise
Reporter 5.0 MP1-RP1 or 5.1 to Enterprise Reporter 5.2 , the installation can fail
to start the ccerweb and sm processes. The issue occurs because the maximum
Java memory (roughly 2GB) can sometimes be consumed in a co-existence setup.
The Cognos logs may show that a "PermGen space" error occurred while stopping
the web server.
Workaround
Restart the web server.
To restart the web server

1

Go to /opt/VRTSweb/bin

2

Execute the following command:
./webgui restart

3

Start the web applications as follows:
■

Go to /opt/VRTSsmweb/webgui and execute the following command:
smw start

■

Go to /opt/VRTSccer/bin and execute the following command:
ccerweb start

■

Go to /opt/VRTSccs/VRTSccsts/bin and execute the following command:
vxccs start gui

■

Go to /opt/VRTSccs/VRTSccsts/bin and execute the following command:
vxccs start scmui

Oracle tablespace creation fails on Windows when the directory name
includes spaces (1720060)
When you install Enterprise Reporter on Windows, the Oracle database server
Tablespace directory field defines the directory in which the installer creates the
required tablespaces and schema for your Oracle database. If you enter a directory
name that includes spaces, the following error message appears when the installer
tries to create the tablespaces:
Oracle Tablespace creation failed because oracle could not create
table space files in host_name. Please ensure the Tablespace Directory
exists and has write permission for oracle user on host_name.
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Workaround
Specify a directory that does not include spaces in its name.

The Enterprise Reporter Console is unusable if you install Enterprise
Reporter 5.2 over Storage Foundation 5.1 or 5.1 SP1 on Solaris
(2085125)
If you install Enterprise Reporter 5.2 over Storage Foundation 5.1 or 5.1 SP1 on
Solaris, you may be unable to use Enterprise Reporter. You may see the following
error when you log in:
[ServletException in:/layouts/RightPane.jsp] null'
java.lang.NullPointerException

Workaround
Obtain the vrtswebenv.sh file from Symantec Technical Support. Copy the
vrtswebenv.sh file into the following directory: /opt/VRTSweb/bin. Then restart
the Enterprise Reporter Console. Enter the following:/opt/VRTSweb/bin/webgui
restart.

The Enterprise Reporter Console is unusable if you install or upgrade
Enterprise Reporter 5.2 over CommandCentral Storage 5.2 on Windows
or Solaris (2088647)
If you install Enterprise Reporter 5.2 over CommandCentral Storage 5.2 on
Windows or Solaris, you may get a servlet exception error and be unable to use
Enterprise Reporter. This is also an issue if you install CommandCentral Storage
5.2 over Enterprise Reporter 5.2.
Workaround
■

On Solaris, run this command:
/opt/VRTSsmweb/webgui/smw restart

■

On Windows, restart the Veritas Storage Management Web Console service
from the Services panel in Windows.

Cognos configuration error message when upgrading to Enterprise
Reporter 5.2 (2135798)
When you upgrade from Enterprise Reporter 5.1 to 5.2, you may get the following
erroneous error message stating that there is a Cognos configuration failure:
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Action: EvaluateObject
BMT-MD-0003 UDA-SQL-0107 A general exception has occurred during the
operation
"prepare". ORA-00942: table or view does not exist
RQP-DEF-0177 An error occurred while performing operation
'sqlPrepareWithOptions'
status='-9'.
UDA-SQL-0107 A general exception has occurred during the operation
"prepare".
ORA-00942: table or view does not exist

This error message does not impact the product functionality and requires no
action on your part. The error message appears in the installation log file
Cognos_Config.log on both Windows and Solaris installations.
Workaround
Although the error message directs you to reconfigure the product, there is no
need to do so. You can ignore the error message.

If you upgrade to SFW 5.1SP1, you may get errors in Enterprise
Reporter 5.2 (2136413)
If you install SFW 5.1SP1 after you install Enterprise Reporter 5.2, you may get
errors in Enterprise Reporter because of a cipher-related issue with JRE 1.6.
Workaround
Apply the JRE 1.6 patch.
To apply the JRE 1.6 patch

1

Go to the Java SE Downloads web site.

2

Click Download next to the following item: Java Cryptography Extension
(JCE) Unlimited Strength Jurisdiction Policy Files 6.
The jce_policy-6.zip file downloads.

3

Uncompress and extract the downloaded file.

4

Copy the local_policy.jar and US_export_policy.jar files to the
<java-home>\lib\security directory on your local drive.

5

Copy the ca.cer file from <cognos-home>/bin to <java-home>/bin. The
<cognos-home> directory is in one of the following locations:
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■
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If you installed Cognos in the default location, it is located here:
C:\Program Files\VERITAS\VRTSccer\Cognos

■

If you did not install Cognos in the default location, it is located here: Your
installation path\Cognos

The <java-home>/bin file is located here: C:\Program Files \Common
Files\Veritas Shared\VRTSjre\jre1.6\bin).

6

From <java-home>\bin, enter the following command:
keytool -import -noprompt -alias ERCogKey -file "C:\Program Files
\Common Files\Veritas Shared\VRTSjre\jre1.6\bin\ca.cer"
-keystore "C:\Program Files\Common Files\Veritas
Shared\VRTSjre\jre1.6\lib\security\cacerts" -storepass changeit

7

Restart the Symantec Web Server, the Veritas Enterprise Reporter Web
Console and Cognos8 from the Services panel in Windows.

When you upgrade from Enterprise Reporter 5.1 to 5.2, the NO ACCESS
role is not an available User Management option (2138339)
The NO ACCESS user management role is a new feature in Enterprise Reporter
5.2 that allows you to create users that have no privileges to use the product.
Assigning this role blocks a user account or user group from accessing Enterprise
Reporter.
When you upgrade from Enterprise Reporter 5.1 to 5.2, you may not see the NO
ACCESS role on the User Management tab. The role may also be missing when
you add a user or group.
Workaround
Update the userManagement.xml file.
To update the userManagement.xml file

1

Open the userManagement.xml file. Go to one of the following locations:
■

On Solaris: /opt/VRTSsmweb/webgui/sm/config/userManagement.xml
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■

On Windows: Enterprise Reporter install
directory\VRTSsmweb\webgui\sm\config\userManagement.xml

2

Edit the userManagement.xml file. In the userManagement.xml file, go to the
Roles section and add the following line:
<Rolename="No Access" description="Has no access to any reports
or data." />

3

Save and close the userManagement.xml file.

4

Restart the Storage Management Web Console. Do one of the following:
■

On Solaris, enter the following command: /opt/VRTSsmweb/webgui/smw
restart

■

On Windows, restart the Veritas Storage Management Web Console service
from the Services panel in Windows.

Console and report issues
The following notes pertain to known issues that you might encounter when you
use the Enterprise Reporter Console and reports.

Tree view in Enterprise Reporter Console not fully Section 508
compliant (1099869)
The tree control that is used in the Enterprise Reporter Console to display business
view hierarchies is not fully Section 508 compliant. Limitations in the tree do not
permit screen reader applications such as JAWS to read the object names in the
tree. There is no workaround for this issue at this time.

Percentage columns averaged in ad hoc report summary lines
(1101752)
If you use Query Studio to create an ad hoc report and you add a summary line to
the report, values within the percentage columns will be averaged. This is a Cognos
limitation.
Workaround
To ensure that your data is correct, determine a formula to access the correct
values from your report. Add a new column to your report that includes this
calculated value.
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Tables show rounded capacity values while charts do not (1108854)
Enterprise Reporter rounds capacity values shown in report tables, but does not
round the values in charts. For example, if a capacity is 0.24, the table displays
“0” while the chart displays “0.24.” Because of this, the sum of individual capacities
does not match the value that appears in the Total.
Workaround
To view the nonrounded capacity values on charts, display the capacity’s ToolTip.

Incorrect used capacity reported for MS-SQL database (1110702)
When you view a report about MS-SQL databases, incorrect used capacity values
may display. This occurs because of a problem in CommandCentral Storage.
Workaround
If you are running CommandCentral Storage on a UNIX host, there is no available
workaround.
If you are running CommandCentral Storage on a Windows host, refer to the
following TechNote:
http://support.veritas.com/docs/287016

Incorrect capacity reported for an application group (1111101)
When you view a report about an application group’s capacity, the capacity values
may be more than what is reported in CommandCentral Storage.
This occurs because of double counted capacity values. If a group contains an
application and the file system that the application uses, the capacity for that
application will be counted twice.
Workaround
When you create a group in CommandCentral Storage, add the application to the
group, but do not include the file system that the application uses.

Security alerts display in Firefox 2.x and 3.x when using Enterprise
Reporter Console (1204355)
When you use Firefox 2.x or 3.x to view the Enterprise Reporter Console, security
alerts similar to the following repeatedly display:
In Firefox 2.x: Firefox can't connect securely to ... because the site
uses a security protocol which isn't enabled.
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In Firefox 3.x: Secure connection failed and the error code
ssl_error_no_cypher_overlap.
Workaround
You can change the default value of an SSL preference in Firefox to avoid these
messages.
To change the default SSL security setting in Firefox

1

In the address bar in Firefox, type
about:config

2

In the Filter field in the page that displays, type
ssl3.rsa_rc4_40_md5
The page refreshes to display the ssl3.rsa_rc4_40_md5 browser preference.

3

Double-click the ss13.rsa_rc4_40_md5 preference so that its status, type, and
value are set as follows:
user set, boolean, true

4

Restart Firefox and reconnect to the Console.

HTTP status exception displays when logging in to the Console
(1476311)
After you install CommandCentral 5.1 or 5.2 on a host that includes Enterprise
Reporter 5.0 MP1, 5.1, or 5.2, when you try to log in to the Enterprise Reporter or
CommandCentral Storage Change Manager Consoles, the following error message
appears:
HTTP status Exception: Unable to compile class for JSP

This issue occurs because the Symantec Web Server is not compatible with Java
1.5.
Workaround
Replace the Symantec Web Server's JDT compiler with two new files (ant.jar
and ant-launcher.jar). Contact Symantec Technical Support to obtain these
files. After you obtain the files, perform the following procedure.
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To replace the Symantec Web Server's JDT compiler with two new files

1

On the Management Server, open the following directory:
/opt/VRTSweb/catalina/common/lib

2

In the directory, rename the file jasper-compiler-jdt.jar to
jasper-compiler-jdt.jar.donotuse

3

Copy and paste ant.jar and ant-launcher.jar into the following directory:
/opt/VRTSweb/catalina/common/lib

4

Type the following command to restart the Symantec Web Server:
/opt/VRTSweb/bin/webgui restart

The Web Server restarts. You can now log in to the Enterprise Reporter and
CommandCentral Storage Change Manager Consoles.

Cognos schedule set to incorrect time zone (1484864)
When you schedule a report to run automatically through Cognos Connection, by
default, the time zone is set to (GMT -05:00) America, Indianapolis.
Workaround
Configure the time zone.
To configure the time zone (Solaris)

1

On the Management Server, open an operating system console and log in as
root.

2

Change to the following directory:
/opt/VRTSccer/bin

3

Set the environment as:
. setenv.sh

4

To load Cognos Configuration, type the following command:
/opt/VRTSccer/cognos/c8/bin/cogconfig.sh

5

Click Action > Edit Global Configuration.

6

Click General.

7

Click the value for Select time zone.

8

From the Server time zone drop-down list, select a time zone.

9

Click OK.
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10 Click File > Save.
11 Click File > Exit.
12 When prompted, restart the Cognos server.
To configure the time zone (Windows)

1

Click Start > Programs > IBM Cognos 8 > IBM Cognos Configuration.

2

Click Action > Edit Global Configuration.

3

Click General.

4

Click the value for Select time zone.

5

From the Server time zone drop-down list, select a time zone.

6

Click OK.

7

Click File > Save.

8

Click File > Exit.

9

When prompted, restart the Cognos server.

Cognos log on screen appears when you view reports in the Home pane
(1631512)
The Cognos log on screen may appear in the Enterprise Reporter Console when
you try to view reports in the Home pane. This issue occurs if you access the
Console from the Management Server and enter "localhost" in the URL (for
example, https://localhost:8443).
Workaround
When you access the Enterprise Reporter Console from the Management Server,
enter the fully-qualified host name of the Management Server in the URL:
https://hostname:8443/

The page cannot be displayed message appears in the Console on
Windows hosts (1665114)
The message The page cannot be displayed may appear in the Enterprise
Reporter Console. When this occurs, it means you may have connected to the
Enterprise Reporter host using the short name, or Partially-Qualified Domain
Name (PQDN), for your machine.
Workaround
Use the Fully Qualified Domain Name (FQDN) to connect.
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To use the fully qualified domain name

1

In Windows, click Control Panel > Network Connections.

2

Open your network connection.

3

Double-click the Internet Protocol (TCP/IP).

4

Click Advanced.

5

Click the DNS tab.

6

Select Append these suffixes.

7

Click Add and then type in the DNS suffix.

Sample reports not visible to users with read-only permissions
(1671894)
An error message may appear when a user with read-only permission tries to view
certain sample reports. The reports do not load in the Console. This issue occurs
with reports that contain an 'HTMLItem' layout element and can be seen on both
Solaris and Windows platforms.
Workaround
Change the permission for the read-only user.
To change the permission for the read-only user

1

Log in to the Enterprise Reporter Console with admin user rights.

2

Click the Manage reports icon.
The Cognos connection screen appears in a new window.

3

On the Cognos connection screen, do the following:
■

Click the Launch link located at top right-side of the screen.

■

From the Launch drop-down list, select IBM Cognos Administration.

4

In the IBM Cognos Administration window, click the Security tab, and then
click Capabilities at the left-side of the screen.

5

In the Capability pane, click Report Studio in the list of available
Capabilities--you may need to click the change page button to find it in the
list.

6

In the Report Studio pane, beside HTML Items in Report, click the Actions
button, and then click Set properties.

7

In the Set properties-HTML Items in Report pane, do the following:
■

Click the Permissions tab.
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■

8

9

Below the Name and Permissions box, click Add.

In the Select entries (Navigate)-HTML Items in Report pane, do the following:
■

In the Available entries Directory box, select the Enterprise Reporter
checkbox.

■

Click the arrow button to move the Enterprise Reporter namespace to the
Selected entries box.

■

Click OK.

In the Permissions tab, do the following:
■

In the Name and Permissions box, select the Enterprise Reporter
checkbox.

■

In the Grant and Deny box, select the Traverse and Execute checkboxes
under the Grant column.

■

Click OK.

10 In the Capability pane, click Report Studio.
11 In the Report Studio screen, do the following:
■

Click the Actions button.

■

Click Set properties.

12 In the Set properties – Report Studio pane, do the following:
■

Select the Permissions tab.

■

Below the Name and Permissions box, click the Add link.

13 In the Select entries (Navigate)-Report Studio pane, do the following:
■

In the Available entries Directory, select the Enterprise Reporter
checkbox.

■

Click the arrow button to move the Enterprise Reporter namespace to the
Selected entries box.

■

Click OK.

14 In the Permissions tab, do the following:
■

In the Name and Permissions box, select the Enterprise Reporter
checkbox.

■

In the Grant and Deny box, select the Traverse checkbox under the Grant
column.

Known issues
Console and report issues

■

Click OK.

15 Log out of the Enterprise Reporter Console, and then log in as a read-only
user to verify the reports can be viewed.

Console session logs out after logging into multiple product consoles
(1676349)
If you log in to the Enterprise Reporter Console and then, on another tab in the
same browser instance, log in to either CommandCentral Storage Change Manager
or Storage Foundation Manager, your session in the Enterprise Reporter Console
logs out. The initial connection terminates regardless of which product you logged
into first. This issue occurs with both Firefox and Internet Explorer.
Workaround
Do not use multiple browser tabs in a single browser instance for logging in to
multiple products. Use a separate browser instance to connect to each product.

RSV-SRV-0030 error appears in Report Studio (1705573)
When you use Report Studio to create reports, you can use the Express mode or
the Professional mode. Typically, the Professional mode is the default mode. If
you use the Express mode, you may receive the following error message when you
load a report in Report Studio:
The report could not run because the feature is not supported or a
server error occurred RSV-SRV-0030 The user does not have the assigned
capability to use HTMLItem.

Workaround
Modify the user interface profile for the Express mode.
To modify the user interface profile for the Express mode

1

Log in to the Enterprise Reporter Console with the admin user account.

2

In the Home pane, click Manage Reports.

3

In the Launch drop-down list, select IBM Cognos Administration.

4

Click Security.

5

In the Security pane, click User Interface Profiles.

6

In the User Interface Profiles table, click the Actions icon that appears next
to the word Express.

7

In the Permissions - Express panel, click Add...
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8

9

In the Select entries (Navigate) - Express panel, do the following:
■

In Available Entries Directory, select Enterprise Reporter.

■

Click the arrow to move the Enterprise Reporter namespace to the selected
entries box.

■

Click OK.

In the Permissions - Express panel, do the following:
■

Check the checkbox for Enterprise Reporter.

■

In the Grant column, check the checkboxes for Traverse and Execute.

■

Click OK.

10 Log out of Enterprise Reporter and close all Web browser windows.
You can now log in to Enterprise Reporter and access Report Studio in the
Express mode.

Incorrect capacities sometimes appear in the SAN Chargeback reports
for EMC CLARiiON arrays (1710248)
Incorrect capacities appear in the SAN Chargeback reports in the following
scenario.
When a host consumes storage from an aggregate LUN that belongs to an EMC
CLARiiON storage array:
■

An incorrect total physical capacity appears in the SAN Chargeback Summary
report.

■

Physical capacity displays as zero in the SAN Chargeback Detail report.

NAS chargeback report can show inaccurate capacities (1714485)
In the NAS Chargeback report, a calculation inaccuracy can occur in the Quota
Limit, Quota Used, Quota Limit Physical, and Quota Used Physical capacities. An
inaccuracy can also occur in any user-created reports that have Quota Limit and/or
Quota Used capacities added. This issue occurs when there are multiple User
and/or Group Quotas defined on a Qtree. In such a case, the NAS chargeback might
display lesser capacities for all the quota capacities.
There is no workaround.
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User management issues
The following notes pertain to known issues that you might encounter when you
manage user accounts.

LDAP users cannot access the Enterprise Reporter Console after
upgrading to 5.2 (1192299)
LDAP users who were able to access the Enterprise Reporter 5.0, 5.0MP1, or 5.1
Console cannot log in after upgrading to 5.2.
Workaround
On the LDAP host, edit the Symantec Product Authentication Service configuration
file named /var/VRTSat/.VRTSat/profile/VRTSatlocal.conf. Add the following
lines after the [Security\Authentication\Authentication
Broker\AtPlugins\ldap\AuthMechanisms\Simple] section.
"AdminUser"=""
"AdminUserPassword"=""
"AuthType"="FLAT"
"SearchScope"="SUB"

Restart the Authentication Service.
/etc/rc2.d/K99vxatd stop
/etc/rc2.d/S70vxatd start

The LDAP users can now log into the Enterprise Reporter 5.2 Console.

No support for Windows Active Directory Server running on Windows
2000 (1949619)
Enterprise Reporter does not support Windows Active Directory Server running
on Windows 2000.

When you upgrade from Enterprise Reporter 5.1 to 5.2, the NO ACCESS
role is not an available User Management option (2138339)
The NO ACCESS user management role is a new feature in Enterprise Reporter
5.2 that allows you to create users that have no privileges to use the product.
Assigning this role blocks a user account or user group from accessing Enterprise
Reporter.

43

44

Known issues
Data rollup issues

When you upgrade from Enterprise Reporter 5.1 to 5.2, you may not see the NO
ACCESS role on the User Management tab. The role may also be missing when
you add a user or group.
Workaround
Update the userManagement.xml file.
To update the userManagement.xml file

1

Open the userManagement.xml file. Go to one of the following locations:
■

On Solaris: /opt/VRTSsmweb/webgui/sm/config/userManagement.xml

■

On Windows: Enterprise Reporter install
directory\VRTSsmweb\webgui\sm\config\userManagement.xml

2

Edit the userManagement.xml file. In the userManagement.xml file, go to the
Roles section and add the following line:
<Rolename="No Access" description="Has no access to any reports
or data." />

3

Save and close the userManagement.xml file.

4

Restart the Storage Management Web Console. Do one of the following:
■

On Solaris, enter the following command: /opt/VRTSsmweb/webgui/smw
restart

■

On Windows, restart the Veritas Storage Management Web Console service
from the Services panel in Windows.

Data rollup issues
The following notes pertain to known issues that you might encounter when you
run data rollup.

Duplicate data source additions (1105915)
When you add a data source to Enterprise Reporter, you can enter any of the
following in the Database server host field:
■

Host name (for example, yourhostname)

■

Fully Qualified Domain Name (FQDN) (for example,
yourhostname.domain.topleveldomain.com)

■

IP address
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You can add the same data source twice if you use different names. No issue occurs
with a duplicate entry of the FQDN and IP address because they point to the same
host. However, if the duplication is with the host name and its FQDN, an issue
occurs because the host sees the data source as two separate data sources.
Workaround
Avoid adding data sources more than once. As a standard practice, add data sources
in the same manner consistently.

NetApp volumes may not roll up from CommandCentral Storage 5.0
RP1 Management Servers (1181735)
If you perform data rollup from a CommandCentral Storage 5.0 RP1 Management
Server, NetApp volumes may not roll up to Enterprise Reporter. This occurs
because of a problem in CommandCentral Storage.
Workaround
For Solaris hosts that run the CommandCentral Storage 5.0 RP1 Management
Server or the managed host with array management, install the latest NetApp
Explorer hotfix. Contact Symantec Technical Support for instructions on how to
acquire the hotfix.
For Windows, AIX, Linux, and HP-UX hosts, there is no workaround. To ensure
that NetApp volumes roll up to Enterprise Reporter, upgrade to CommandCentral
Storage 5.0 MP1.

After upgrading CommandCentral Storage to 5.0 MP1, data rollup fails
(1322617)
If you added a CommandCentral Storage 5.0 Management Server as a data source
and then you upgrade that Management Server to 5.0 MP1, when Enterprise
Reporter attempts to rollup data from that Management Server, data rollup fails.
Workaround
Resave the data source in the Enterprise Reporter Console.
To resave the data source in the Enterprise Reporter Console

1

In the Enterprise Reporter Console, click Data Management > Data Rollup
Configuration > Data Sources.

2

Select the data source for which data rollup failed.

3

In the Data Sources dialog box, click Save Changes.

4

Restart the data rollup process for the data source.
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Data rollup does not start after a failed data rollup on Windows
(1670600)
If data rollup fails on a Windows host, subsequent data rollups may not start.
Workaround
Reschedule the data rollup task.
To reschedule the data rollup task

1

Log in to the Management Server as a user with administrator-level privileges.

2

In a command prompt, change to the following directory:
install_location\VRTSccer\bin

Where install_location is the directory in which you installed Enterprise
Reporter. The default install directory for Windows is C:\Program
Files\VERITAS

3

To remove the scheduled task that initiates data rollup, type the following
command:
etl_scheduler --uninstall

4

To add the scheduled task that initiates data rollup, type the following
command:
etl_scheduler --setup

The wrong version shows when you configure CommandCentral Storage
5.2 data sources in Enterprise Reporter 5.2 (2146075)
When you configure the CommandCentral Storage 5.2 data source on the
Enterprise Reporter 5.2 Data Management tab, the data source erroneously displays
as CommandCentral Storage 5.1 instead of CommandCentral Storage 5.2. This
occurs even though the data source is actually CommandCentral Storage5.2. This
happens on both Windows and Solaris, and has no impact on product functionality.

Business view issues
You might encounter the following known issues when you work with business
views.

Known issues
Documentation issues

Business view import fails if IP address entries are longer than 256
characters (1630281)
When you import business views into Enterprise Reporter, the following error
message may appear:
Error: Failed executing SQL*Loader: sqlldr parfile=<filename>
control=<filename> log=<filename> > NUL:

The import fails because an IP address entry in the object assignment CSV file is
longer than 256 characters.
Workaround
Open the object assignment CSV file and delete the IP address column entries.
Then, import the business view.

Documentation issues
This section provides information about last-minute changes to the documentation
and online help.

Configuring the Authentication Service instructions are incorrect in
the Enterprise Reporter 5.2 online help
The instructions for configuring the Authentication Service for LDAP are incorrect
in the Enterprise Reporter 5.2 online help. The correct instructions appear in the
CommandCentral Administrator’s Guide.
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Appendix

A

Getting help
This appendix includes the following topics:
■

About CommandCentral Enterprise Reporter documentation

■

Contacting Symantec

About CommandCentral Enterprise Reporter
documentation
You can access Enterprise Reporter documentation at the Symantec Technical
Support web site:
www.symantec.com/enterprise/support/documentation.jsp?pid=54971
Table A-1 describes the Enterprise Reporter documentation.
Table A-1

Enterprise Reporter documentation

Guide

Description

CommandCentral Enterprise
Reporter Release Notes

Provides information about supported operating systems,
host resource requirements, software limitations, and
known issues.

CommandCentral Getting
Started Guide

Provides a high level overview of how you can use
Enterprise Reporter.

CommandCentral Enterprise
Reporter Installation Guide

Instructs you how to install Enterprise Reporter.

CommandCentral Enterprise
Reporter User's Guide

Describes how you can use Enterprise Reporter to create
and manage reports.
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Table A-1

Enterprise Reporter documentation (continued)

Guide

Description

CommandCentral Enterprise
Provides information about managing your data, including
Reporter Administrator’s Guide rolling up data from CommandCentral Storage and
managing storage tiers, business views, and custom
attributes. The guide also includes information about
managing licenses and user accounts.
CommandCentral Enterprise
Reporter Third-Party License
Agreements

Provides information about third-party software that is
used in Enterprise Reporter.

Commenting on product documentation
Submit comments about the product documentation to the following email address:
storage_management_docs@symantec.com
Please include the following information with your documentation comments:
■

The title and product version of the guide you are commenting on

■

The topic (if relevant) you are commenting on

■

Your comment

■

Your name

Contacting Symantec
You can contact Symantec on the Web, by email, or by telephone.

Using the support web site
For technical assistance with any Symantec product, visit the Symantec Support
Web site:
http://www.symantec.com/enterprise/support/assistance_care.jsp
From there you can:
■

Contact the Symantec Support staff and post questions to them

■

Get the latest software patches, upgrades, and utilities

■

View updated hardware and software compatibility lists

■

View Frequently Asked Questions (FAQ) pages for the products you are using
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■

Search the knowledge base for answers to technical support questions

■

Receive automatic notice of product updates

■

Find out about training in the Storage Foundation products

■

Read current white papers related to the Storage Foundation products

Subscribing to email notification service
Subscribe to the Symantec Email notification service to be informed of software
alerts, newly published documentation, Beta programs, and other services.
Go to the following Web site:
http://www.symantec.com/enterprise/support/assistance_care.jsp
Select a product and click E-mail Support at the bottom of the page. Your customer
profile ensures that you receive the latest Symantec technical information
pertaining to your specific interests.

Accessing telephone support
Telephone support is available with a valid support contract. To contact Symantec
for technical support, dial the appropriate phone number listed on the Support
Guide included in the product box and have your product license information
ready for quick navigation to the proper support group.

Obtaining support by email
Licensed customers can use the following email address to obtain help with
technical questions:
support@veritas.com
To obtain software updates by email, send your requests to the following email
address:
swupdate@veritas.com

Obtaining license information
To obtain license information, contact Symantec in one of the following ways:
■

U.S. and Canada telephone: 1-800-634-4747 option 3

■

Worldwide fax: +1-650-527-0952

■

Email:
amercustomercare@veritas.com
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Purchasing products
For help with purchasing Symantec products, visit the Symantec Web site:
http://www.symantec.com
where you can chat with product experts or link to information about the products.
You can also contact a Symantec product representative by email at the following
address:
sales.mail@veritas.com
To speak with a Symantec product representative by telephone, customers in the
U.S. and Canada can call 1-800-327-2232.

